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Preface

This guide describes the system and client requirements, installation procedures, 
and troubleshooting suggestions for the CiscoWorks Common Services software.

Audience
This guide is for anyone who installs, configures, verifies, and uses CiscoWorks 
Common Services software. Network administrators or operators should have the 
following skills:

• Basic Windows system administrator skills

• Basic network management skills

Conventions
This document uses the following conventions:

Item Convention

Commands and keywords boldface font

Variables for which you supply values italic font
vii
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Displayed session and system information screen font

Information you enter boldface screen font
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Conventions

Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication. 

Caution Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Variables you enter italic screen font

Menu items and button names boldface font

Selecting a menu item in paragraphs Option > Network Preferences

Seleting a menu item in tables Option > Network Preferences

Item Convention
viii
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Product Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should review the documentation on Cisco.com for 
the latest updates.

Table 1 describes the product documentation that is available.

Table 1 Product Documentation

Document Title Available Formats

Release Notes for CiscoWorks 
Common Services 2.2 (includes 
CiscoView 5.5) on Windows

• Printed document that was included with the product.

• On Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/c
w2000/cw2000_d/comser22/relnote/index.htm

Installation and Setup Guide for 
Common Services (Includes 
CiscoView) on Windows

• PDF on the product CD-ROM.

• On Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/c
w2000/cw2000_d/comser22/ig_wincv/index.htm

• Printed document available by order (part number 
DOC-7815430=).1

User Guide for CiscoWorks 
Common Services

• PDF on the product CD-ROM.

• On Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/c
w2000/cw2000_d/comser22/usrguide/index.htm

• Printed document available by order (part number 
DOC-7815301=).1

Context-sensitive Online Help • Select an option from the navigation tree, then click Help.
ix
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1. See the “Obtaining Documentation” section on page xi.

• Click the Help button in the dialog box.
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http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/cw2000_d/comser22/relnote/index.htm
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/cw2000_d/comser22/ig_wincv/index.htm 
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Related Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should review the documentation on Cisco.com for 
the latest updates.

Table 2 describes the additional documentation that is available.

Table 2 Related Documentation

Document Title Available Formats

User Guide for CiscoView 5.5 • On Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/c
w2000/cw2000_d/comser22/use_view/index.htm

• Printed document available by order (part number 
DOC-7815219=).1
x
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Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and 
other technical resources. These sections explain how to obtain technical 
information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at 
this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco websites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which may have shipped with your product. 
The Documentation CD-ROM is updated regularly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual or quarterly subscription.

Registered Cisco.com users can order a single Documentation CD-ROM (product 
number DOC-CONDOCCD=) through the Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/ordering_place_order_ordering_t
ool_launch.html

All users can order monthly or quarterly subscriptions through the online 
Subscription Store:

http://www.cisco.com/go/subscription
xi
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Obtaining Documentation

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Networking Products MarketPlace:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by 
calling 800 553-NETS (6387). 

Documentation Feedback
You can submit comments electronically on Cisco.com. On the Cisco 
Documentation home page, click Feedback at the top of the page.

You can e-mail your comments to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
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Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center 
(TAC) website, as a starting point for all technical assistance. Customers and 
partners can obtain online documentation, troubleshooting tips, and sample 
configurations from the Cisco TAC website. Cisco.com registered users have 
complete access to the technical support resources on the Cisco TAC website, 
including TAC tools and utilities. 

Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access 
Cisco information, networking solutions, services, programs, and resources at any 
time, from anywhere in the world. 

Cisco.com provides a broad range of features and services to help you with these 
tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com 
at this URL:

http://tools.cisco.com/RPF/register/register.do

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with 
a Cisco product, technology, or solution. Two types of support are available: the 
Cisco TAC website and the Cisco TAC Escalation Center. The type of support 
that you choose depends on the priority of the problem and the conditions stated 
xiii
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We categorize Cisco TAC inquiries according to urgency:

• Priority level 4 (P4)—You need information or assistance concerning Cisco 
product capabilities, product installation, or basic product configuration. 
There is little or no impact to your business operations.

• Priority level 3 (P3)—Operational performance of the network is impaired, 
but most business operations remain functional. You and Cisco are willing to 
commit resources during normal business hours to restore service to 
satisfactory levels.

• Priority level 2 (P2)—Operation of an existing network is severely degraded, 
or significant aspects of your business operations are negatively impacted by 
inadequate performance of Cisco products. You and Cisco will commit 
full-time resources during normal business hours to resolve the situation.

• Priority level 1 (P1)—An existing network is “down,” or there is a critical 
impact to your business operations. You and Cisco will commit all necessary 
resources around the clock to resolve the situation.

Cisco TAC Website

The Cisco TAC website provides online documents and tools to help troubleshoot 
and resolve technical issues with Cisco products and technologies. To access the 
Cisco TAC website, go to this URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract 
have complete access to the technical support resources on the Cisco TAC 
website. Some services on the Cisco TAC website require a Cisco.com login ID 
and password. If you have a valid service contract but do not have a login ID or 
password, go to this URL to register:

http://tools.cisco.com/RPF/register/register.do

If you are a Cisco.com registered user, and you cannot resolve your technical 
issues by using the Cisco TAC website, you can open a case online at this URL:

http://www.cisco.com/tac/caseopen

If you have Internet access, we recommend that you open P3 and P4 cases online 
xiv
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Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 
issues. These classifications are assigned when severe network degradation 
significantly impacts business operations. When you contact the TAC Escalation 
Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a 
case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, 
go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the 
Cisco support services to which your company is entitled: for example, 
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). When 
you call the center, please have available your service agreement number and your 
product serial number.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• The Cisco Product Catalog describes the networking products offered by 
Cisco Systems, as well as ordering and customer support services. Access the 
Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of networking publications. Cisco 
suggests these titles for new and experienced users: Internetworking Terms 
and Acronyms Dictionary, Internetworking Technology Handbook, 
Internetworking Troubleshooting Guide, and the Internetworking Design 
Guide. For current Cisco Press titles and other information, go to Cisco Press 
online at this URL:

http://www.ciscopress.com
xv
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• Packet magazine is the Cisco quarterly publication that provides the latest 
networking trends, technology breakthroughs, and Cisco products and 
solutions to help industry professionals get the most from their networking 
investment. Included are networking deployment and troubleshooting tips, 
configuration examples, customer case studies, tutorials and training, 
certification information, and links to numerous in-depth online resources. 
You can access Packet magazine at this URL:

http://www.cisco.com/go/packet

• iQ Magazine is the Cisco bimonthly publication that delivers the latest 
information about Internet business strategies for executives. You can access 
iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_
protocol_journal.html

• Training—Cisco offers world-class networking training. Current offerings in 
network training are listed at this URL:

http://www.cisco.com/en/US/learning/le31/learning_recommended_training
_list.html
xvi
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C H A P T E R 1
Prerequisites

This chapter describes the factors that you should consider before installing 
CiscoWorks Common Services on a Windows system. It contains:

• Product Overview

• Server Requirements

• Client Requirements

• Supported Devices

• Supported Network Management System Environments

Product Overview
CiscoWorks Common Services, the foundation for the CiscoWorks family of 
products and other Cisco product families, enables the deployment, monitoring, 
and troubleshooting of devices across your network. CiscoWorks Common 
Services includes:

• CiscoWorks Common Services 2.2—A set of shared application services.

• CiscoView 5.5—A graphical device management tool.

• Integration Utility 1.5—An integration module that supports third-party 
Network Management Systems (NMS).
1-1
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Server Requirements

CiscoWorks Common Services Upgrade
Table 1-1 describes the different local upgrade paths and results. See the 
“Installing CiscoWorks Common Services” chapter for installation instructions.

Server Requirements
The minimum system requirements for installing CiscoWorks Common Services 
are shown in Table 1-2.

Table 1-1 Upgrade Paths

Existing Software Results

Clean machine CiscoWorks Common Services is installed in the specified directory.

CiscoWorks 
Common Services 
2.2

Reinstallation of CiscoWorks Common Services overwrites the previously 
installed Common Services components. All data is preserved.

CD One, 5th Edition CiscoWorks Common Services overwrites the previously installed Common 
Services components. All data is preserved.

CD One, 5th Edition 
+ Core 1.0

CiscoWorks Common Services overwrites the previously installed Common 
Services components. All data is preserved.

CD One, 4th Edition CiscoWorks Common Services overwrites the previously installed Common 
Services components. All data is preserved.

Core 1.0 CiscoWorks Common Services overwrites the previously installed Common 
Services components. All data is preserved.

Table 1-2 Server System Requirements1

Requirement 
Type Minimum Requirements

System hardware • IBM PC-compatible system with 500 MHz Intel Pentium processor.

• Color monitor.
1-2
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Note Installation will continue with a warning message on a Windows Advanced 
Server if the terminal services is enabled with remote admin mode, and aborts 
when terminal server is enabled in application mode.

Available drive 
space2

• 2 GB.

• Paging file space equal to double the amount of memory (RAM). For example, 
if your system has 256 MB of RAM, you need 512 MB of page file.

• NTFS file system required for secure operation.

• At least 16 MB in Windows temporary directory (%TEMP%).

System software3 • ODBC Driver Manager 3.5.10. 

• Windows Professional or Server with Service Pack 3.

• Windows Advanced Server without enabling terminal services.

Note CiscoWorks Common Services 2.2 supports only US-English and Japanese 
versions of Windows Operating Systems. It does not support any other 
language version. Set the default locale to US-English for US-English 
version and Japanese for Japanese version.

Additional 
software
(Optional)

Browsers

• Microsoft Internet Explorer 6.0 (version 6.0.2600.0000), and Internet Explorer 
6.0 with Service Pack 1 (version 6.0.2800.1106), Java Virtual Machine (JVM) 
5.0.0.3802 and later, and Java Plug-in version 1.3.1.
To verify the JVM, select View > Java Console from Internet Explorer. 

• Netscape Navigator 4.78 and 4.79.

1. Minimum requirements vary, depending on which components you choose to install: 
Integration Utility alone requires 256 MB RAM and 50 MB disk space.
CiscoView requires 512 MB RAM and 96 MB disk space.

2. Do not install CiscoWorks on a FAT file system.

3. You cannot install CiscoWorks on a system configured as a primary or backup domain controller .
Do not install CiscoWorks in an encrypted directory. CiscoWorks does not support directory encryption.

Table 1-2 Server System Requirements1 (continued)

Requirement 
Type Minimum Requirements
1-3
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Client Requirements

Caution Do not use non-standard java options through _JAVA_OPTIONS environment 
variable.

Client Requirements
The minimum system requirements for the client are shown in Table 1-3. For 
information about configuring client systems, see the Preparing to Use 
CiscoWorks Common Services chapter.

Table 1-3 Client System Requirements

Requirement Type Minimum Requirements

System hardware 
and software

• Client system:

– IBM PC-compatible system with at least a 300 MHz Pentium processor 
running Windows 2000 with Service Pack 3 (Professional and Server), 
Windows XP SP1. 
SPARC Ultra 10 running Solaris 2.7 or 2.8.

• Color monitor with video card set to 256 colors.
1-4
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Memory (RAM) 256 MB.

Browser One of these browsers:

On Windows and Windows XP clients:

• Microsoft Internet Explorer 6.0 (version 6.0.2600.0000) or Internet Explorer 
6.0 with Service Pack 1(version 6.0.2800.1106) 

• Java Virtual Machine (JVM) 5.0.0.3802 and later, and Java Plug-in version 
1.3.1.

To verify the JVM:
From Internet Explorer, select View > Java Console. 
From Netscape Navigator, select Tools > Server > Java Console. 

• Netscape Navigator 4.78 and 4.79.

On Solaris clients:

• Netscape Navigator 4.76 for Solaris 2.7 and 2.8.

Caution For Solaris, use Netscape Navigator downloaded from Sun site only.

Table 1-3 Client System Requirements (continued)

Requirement Type Minimum Requirements
1-5
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Supported Devices
CiscoView manages and configures different types of Cisco devices. See Using 
CiscoView 5.5 for supported device information.

Supported Network Management System 
Environments

The NMS supported for importing device information into the CiscoView 
application is HP OpenView Network Node Manager. See Using CiscoView 5.5 
and the online help for information about importing devices.

You must stop HP OpenView before installing CiscoWorks Common Services, 
restart HP OpenView after you have installed CiscoWorks Common Services. 
Otherwise, the installation will take longer to complete. 
1-6
Installation and Setup Guide for Common Services (Includes CiscoView) on Windows

78-15430-01



 

Installation and Setup Guide for Common Servi
78-15430-01
C H A P T E R 2
Installing CiscoWorks Common 
Services

This chapter consists of:

• Installation Overview

• Preparing to Install CiscoWorks Common Services

• Performing a New Installation

• Performing an Upgrade Installation

• Verifying the Installation

• Uninstalling CiscoWorks Common Services

Installation Overview
This section provides overview of CiscoWorks Common Services installation 
task. Table 2-1 contains references to more detailed information about each task. 
2-1
ces (Includes CiscoView) on Windows
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Installation Overview

Installation Notes
During installation, you might see warnings from the Windows system that it has 
found a read-only file. 

You might also see warnings that the installation system is running out of disk 
space. You can choose to free disk space on the system and click Yes to continue, 
or click No to exit the installation.

Table 2-1 Installing CiscoWorks Common Services Task Overview

Task Steps References

Prepare to install 
CiscoWorks 
Common Services.

1. Verify server requirements are 
met

“Prerequisites” chapter, “Server 
Requirements” section on page 1-2

2. Install required Microsoft 
software on the server if it is not 
already installed

“Installing the Required Microsoft 
Software” section on page 2-4

3. Verify client requirements are 
met

“Prerequisites” chapter, “Client 
Requirements” section on page 1-4

4. Verify TCP ports that 
CiscoWorks uses and check for 
conflicts with existing 
applications

“TCP and UDP Ports Used” section on 
page 2-5

Install server 
software.

Run the installation program “Performing a New Installation” section 
on page 2-7

“Performing an Upgrade Installation” 
section on page 2-16

Verify and 
troubleshoot 
installation.

1. Verify that all correct services 
are installed

“Verifying the Installation” section on 
page 2-30

2. Analyze installation error 
messages

“Troubleshooting the Installation” 
appendix, “Understanding Installation 
Messages” section on page A-4 
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Note Do not select an encrypted directory. CiscoWorks does not support directory 
encryption.
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Preparing to Install CiscoWorks Common Services 
Before you install CiscoWorks Common Services, make sure your server and 
client environments meet the hardware and software requirements described in 
the “Prerequisites” chapter. 

While preparing to install CiscoWorks Common Services,

• Do not install CiscoWorks on a system that is configured as a primary or 
backup domain controller.

• Do not install CiscoWorks on a FAT file system.

• Do not install CiscoWorks on Windows XP.

• Run the installation from a local CD or a local hard drive to avoid errors due 
to slow network performance.

• Close all applications before running CiscoWorks installation.

• Do not run any other program when installation is in progress.

• Do not install on Advanced Server with terminal services enabled in 
application server mode.

Note If you are running HP OpenView, the installation might take significantly 
longer to complete. Stop all HP OpenView services before installing 
CiscoWorks Common Services.
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Installing the Required Microsoft Software
Installing CiscoWorks Common Services requires three or more Microsoft 
software applications. This depends on your system. The major steps required for 
installing the CiscoWorks Common Services software are:

1. Make sure the system has Microsoft Windows or Advanced server with 
service pack 3 installed. 

To verify the existing service pack:

a. From the Start menu, select Run and enter winver.

If version 5.0 Service Pack 3 appears in the Version field, Service 
Pack 3 is already installed.

If this information does not appear, Service Pack 3 is not installed. Install it 
now. 

2. Make sure Microsoft Internet Explorer 6.0 is installed in the client and is 
running JVM version 5.0.0.3802 and later. To verify the JVM version:

a. From the browser, select View > Java Console. 

b. If Java Console is not listed in View, enable it. Select Tools  >  Internet 
Options  > Advanced. 

c. In the Microsoft VM section, select the Java Console enabled. 

d. Restart Internet Explorer.

3. Make sure ODBC Driver Manager 3.5.10 or later is installed. To verify the 
version of ODBC Driver Manager:

a. From the Windows desktop, select Start > Settings > Control Panel > 
Administrative Tools > Data Sources (ODBC).

b. Select the About tab. 

If necessary, install Microsoft Data Access Component (MDAC) 2.5 or later. 

4. Make sure that all ODBC Core Components have the same version number. 
See the Microsoft web site for installation instructions.

The download and installation programs for these software packages might be 
changed by Microsoft at their discretion. Therefore, it is not possible to provide 
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Remember these points while installing the required server software:

• Always keep the newer file when you are prompted by an installation 
program to replace a newer file with an older file.

• Always reboot your system when you are prompted to do so by an installation 
program.

• You might be asked to register with Microsoft before downloading some of 
the required software. Complete the registration. Selections you make during 
registration will not affect the installation.

TCP and UDP Ports Used
CiscoWorks Common Services uses the following TCP and UDP ports.

Incoming Ports

The following ports are used for incoming traffic:

• 42343/tcp (JRun)

• 57860/tcp (JRun Server Manager ControlServer - Used for Jrun 
Administration)

• 42344/tcp (ANI HTTP server)

• 514/udp (Standard port for Syslog)

• 1741/tcp (port used for the CiscoWorks HTTP server)

• 1742/tcp (used when the webserver is running on SSL mode)

See the “Preparing to Use CiscoWorks Common Services” chapter for 
information on accessing the server.

• Database ports: 43441-43449 (Different applications uses different ports.
For example, CiscoWorks Common Services uses 43441 and Essentials uses 
43442)

• 443/tcp (port used for Core Apache Web server in SSL mode)

• 9007/tcp (Ajp12 connector used by Tomcat)
2-5
Installation and Setup Guide for Common Services (Includes CiscoView) on Windows

78-15430-01

• 9009/tcp (Ajp13 connector used by Tomcat)

• 1751/tcp (port used for the Core Apache Web server).
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Outgoing Ports

The following ports are used for outgoing traffic:

• 161/udp (Standard port for SNMP Polling)

• 162/udp (Standard port for SNMP Traps)

• 23/tcp (Standard port for Telnet)

• 22/tcp (Standard port for SSH)

• 80/tcp (Default HTTP for device navigator).

Incoming and Outgoing Ports

The following ports are used for incoming and outgoing traffic:

• 42340/tcp (CiscoWorks Daemon Manager, the tool that manages server 
processes)

• 42342/udp (Osagent)

• 42352/tcp (default port; alternate port: 44352/tcp) (ESS HTTP port)

• 69/udp (Standard port for TFTP)

• 1683 (IIOP port for CiscoWorks gatekeeper)

• 8088 (HIOP port for CiscoWorks gatekeeper)

• 514/tcp (RCP port)

• 42351/tcp (default port; alternate port: 44351/tcp) (ESS Listening port)

• 42353/tcp (default port; alternate port: 44353/tcp) (ESS Routing port)

• 42350/udp (default port; alternate port: 44350/udp (ESS Service port)

• 10033 (licensing database port)

• 1684/tcp (IIOP gatekeeper port).
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Performing a New Installation
The CiscoWorks Common Services installation program takes approximately 20 
minutes to complete on a Windows system with the minimum required hardware. 
This can extend to one hour if you perform network management integration 
during the installation process. 

For information on setting up multi-homed systems, see the Release Notes for 
CiscoWorks Common Services 2.2 (Includes CiscoView 5.5) on Windows. 

Running the Installation Program—New Installation
To run the installation program:

Step 1 Install the required software as described in the “Server Requirements” section on 
page 1-2.

• If you are running Windows, make sure Service Pack 3 is installed. 

Note With service Pack 2, CiscoWorks Common Services will install with a 
warning to proceed at your own risk. 

• If you have Service Pack 1, the installation stops.

• If you are running virus scan while installing CiscoWorks Common Services, 
the installation might take longer to complete.

• If you are running HP OpenView, the installation might take significantly 
longer to complete. Stop all HP OpenView services before installing 
CiscoWorks Common Services. 

Insert the CiscoWorks Common Services CD-ROM into a CD-ROM drive. The 
Installer screen appears.

Step 2 Click Install to continue. 

The Welcome screen appears.
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Step 3 Click Next to continue. 

The software License Agreement dialog box appears.
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Step 4 Click Yes to accept the license agreement and proceed with the installation.

The Setup Type dialog box appears. 

To deny the agreement and stop the installation, click No.

Step 5 Select one of the following:

• Express to install all CiscoWorks Common Services components in the 
default location with default settings.
(See the “New Installation—Express” section.)

• Typical to select CiscoWorks Common Services components and install the 
selected components in a specific location. This is the default installation 
mode.
(See the “New Installation—Typical” section.)

• Custom to select optional components, customize the settings, and to specify 
the location.
(See the “New Installation—Custom” section.)

New Installation—Express
If you select the Express option: 

Step 1 Click Next to continue. 

The installation program checks dependencies and system requirements. The 
Requirements Verification dialog box appears. 

The Requirements Verification dialog displays the system requirements, 
available space in the drive and Temp Directory (%TEMP%), and available 
memory in megabytes.

• If your system does not meet the requirements a warning appears:

System memory is less than the minimum requirement, which may 
affect performance.

• If the drive does not have enough space, an error message appears:
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There is not enough space in drive drive name. Please select 
another drive, or free some space on drive drive name.
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Step 2 Click Next to continue. 

The Change Admin Password dialog box appears.

Step 3 Enter the admin password and confirm it.

For more information on passwords, see “Password Information” appendix.

Step 4 Click Next to continue.

Change Casuser Password dialog box appears. The dialog box appears only if the 
random password generated by the installation is rejected by Windows.

Casuser is the user who administers and maintains CiscoWorks server without 
having root privileges. 

Step 5 Enter a password and confirm it. 

This password must conform to the system administrator policies. If you do not 
enter a password, the installation program generates a random password. The 
installation program adds the new user casuser and the new group casusers to the 
system.

For more information on passwords see “Password Information”appendix.

Step 6 Click Next to continue. 

The Summary dialog box appears displaying the summary of settings for the 
installation.

If you want to view passwords and security sensitive data, click Show Details. 
You can select and copy the data from the summary dialog box. 

Step 7 Click Next to continue. 

After the installation is completed, End of Installation dialog box appears.

Step 8 Select Yes, then click Finish.
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To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.

Caution You must restart your system after installation is complete. The installation of 
other CiscoWorks products can fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation” 
appendix.

New Installation—Typical
If you select Typical option: 

Step 1 Click Next to continue.

The Destination dialog box appears with the default location. 

To select another location, click Browse.

Step 2 Click Next to continue.

The Select Component dialog box appears.

Step 3 Select the components you want to install:

Note If CiscoWorks Common Services has been installed previously on this 
system, the list of components will be different.

1. CiscoWorks Common Services 2.2 (CWCS) to install CiscoWorks 
Common Services 2.2.
(Select this option only if you do not want CiscoView 5.5 or Integration 
Utility1.5 installed.)

2. CiscoView 5.5 to install both CiscoView and CiscoWorks Common Services.

3. Integration Utility 1.5.
(For information about the Integration Utility and third-party NMS 
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Step 4 Click Next to continue. 

The installation program checks dependencies and system requirements. The 
Requirements Verification dialog box appears. 

The Requirements Verification dialog displays the system requirements, 
available space in the drive and Temp Directory (%TEMP%), and available 
memory in megabytes.

• If your system does not meet the requirements, a warning appears: 

System memory is less than the minimum requirement, which may 
affect performance.

• If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Please select 
another drive, or free some space on drive drive name.

Step 5 Click Next. 

The Change Admin Password dialog box appears.

Step 6 Enter the password and confirm it. 

For more information on passwords, see “Password Information”appendix.

Step 7 Click Next to continue.

Change Casuser Password dialog box appears. 

This dialog box appears only if the random password generated by the installation 
is rejected by Windows. 

Casuser is the user who administers and maintains CiscoWorks Server without 
having adminstrative privileges. 

Step 8 Enter the casuser password and confirm it. 

The password must conform to the system administrator policies. If you do not 
enter a password, the installation program generates a random password and adds 
the new user casuser and the new group casusers to the system.

Step 9 Click Next to continue. 

The Summary dialog box appears, displaying the summary of settings for the 
installation.
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If you want to view passwords and security sensitive data, click Show Details. 
You can select and copy the data from the summary dialog box. 
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Step 10 Click Next to continue. After the installation is completed, End of Installation 
dialog box appears.

Step 11 Select Yes, then click Finish.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.

Caution You must restart your system after installation is complete. The installation of 
other CiscoWorks products can fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation” 
appendix.

New Installation—Custom
If you select the Custom option:

Step 1 Click Next to continue. 

The Select Destination dialog box appears.

Step 2 Click Next to accept the default location or select another location and click OK, 
then click Next. 

Do not select an encrypted directory. CiscoWorks does not support directory 
encryption.

The Select Components dialog box appears.
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Step 3 Select the components you want to install:

1. CiscoWorks Common Services 2.2 (CWCS) to install CiscoWorks 
Common Services.
(Select this option only if you do not want CiscoView 5.5 or Integration 
Utility1.5 installed.)

2. CiscoView 5.5 to install both CiscoView 5.5 and CiscoWorks Common 
Services 2.2.

3. Integration Utility 1.5.
(For information about the Integration Utility and third-party NMS 
integration, see Using CiscoView.) 

Step 4 Click Next to continue. 

The Requirements Verification dialog box appears. It displays the system 
requirements, available space in the drive and Temp Directory(%TEMP%), and 
available memory in megabytes.

• If your system does not meet the requirements a warning appears: 

System memory is less than the minimum requirement, which may 
affect performance.

• If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Please select 
another drive, or free some space on drive drive name.

Step 5 Click Next to continue. 

The Change Admin and Guest Password dialog box appears.

Step 6 Enter Admin and Guest passwords and confirm it. 

For more information on passwords, see “Password Information”appendix.

Step 7 Click Next to continue installation. 

The Casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server without 
having administrative privileges. 

Step 8 Enter the password and confirm it.

If you do not enter a password, the installation program generates a random 
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password and adds the new user casuser and the new group casusers to the 
system.
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Step 9 Click Next to continue installation. 

The User Management dialog box appears. This dialog box allows you to specify 
whether the users are managed locally by CiscoWorks Common Services or by 
the Access Control Server (ACS).

• If you choose to manage users locally, then click Next. CiscoWorks Common 
Services Database Password dialog box appears. Skip to Step 11.

• If you choose ACS option, then click Next. Access Control Server dialog box 
appears.

Step 10 Enter Access Control Server information. 

Installation does not attempt to access ACS. You can modify the ACS properties 
later using the user administration.

Step 11 Click Next to continue installation. 

The CiscoWorks Common Services Database Configuration dialog box appears. 
Enter the CiscoWorks Common Services Database password and confirm it.

Step 12 Click Next to continue installation. 

The Licensing Database Configuration dialog box appears. 

Step 13 Enter the port number, password, and confirm it.

Step 14 Click Next to continue installation. 

The Web Server Configuration dialog box appears. 

Step 15 Enter HTTPS port, server administrator e-mail address, and the SMTP server 
name. The SMTP server name is used by other CiscoWorks modules.

Step 16 Click Next to continue installation. 

The Self-signed Certificate dialog box appears. The webserver uses the 
self-signed certificate while operating in secure mode. 

Step 17 Enter the country code, state, city, company, organization, and host name for 
HTTPS.

The host name is mandatory.

Step 18 Click Next to continue installation. 

The Shortcut Creation dialog box appears. 
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Step 19 Click Next to continue installation. 

The Integration Utility dialog box appears.

Step 20 Select one of the following:

• Integrate Later to integrate with a third-party NMS after installation. This 
completes the installation more quickly and avoids installation failure due to 
errors in the third-party integration.
If you select Later, skip to Step 21.

• Integrate Now to integrate with a third-party NMS during installation.
If you select Integrate Now, continue with steps a through d.

a. Click Next to continue. The Integration Utility dialog box appears, 
displaying a list of adapters.

b. Select the adapter from the list of available adapters, or other to choose 
an adapter that is not listed (you will be prompted to enter the path name 
of the adapter), or none to integrate after the installation is complete.
If you select none, skip to Step 22.

The Integration Utility dialog box appears. Specify whether you want to 
enable download options from the Cisco Web page (Cisco.com).

Note If you are installing only the Integration Utility, enter the CiscoWorks 
Server name, protocol type (HTTP, HTTPS) and port number.

c. Select one of the following:

– No to disable future upgrades from the Cisco Web page. 

– Yes to enable future upgrades from the Cisco Web page.

d. Enter your Cisco.com user ID and password.

You must have Cisco.com login privileges. If you do not have a user 
account and password on Cisco.com, contact your channel partner or 
enter a request on the standard Cisco.com web site (www.cisco.com).

Step 21 Click Next to continue. 

The Summary dialog box appears, displaying the summary of settings for the 
installation.
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To view passwords and security sensitive data, click Show Details. You can 
select and copy the data from the Summary dialog box. 
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Step 22 Click Next to continue. 

After the installation is completed, End of Installation dialog box appears.

Step 23 Select Yes and click Finish.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.

Caution You must restart your system after installation is complete. The installation of 
other CiscoWorks products may fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation” 
appendix.

Performing an Upgrade Installation
CiscoWorks Common Services 2.2 supports upgrade from:

• CD One, 5th Edition

• CD One, 4th Edition

• CD One, 5th Edition + CORE 1.0

• CORE1.0

The data is preserved when you perform an upgrade.

For a description of the different upgrade paths and their results, see the “Upgrade 
Paths” section on page 1-2.
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Upgrading from Earlier Versions
You can upgrade to CiscoWorks Common Services 2.2 using either of two 
methods: 

• Perform a local upgrade by installing the new version on the system currently 
running a previous version.

or

• Perform a remote upgrade by installing 
Common Services 2.2 on a new system and exporting essential data from the 
system running earlier editions of CiscoWorks to the new system. 

To perform a local upgrade, see “Upgrading from earlier versions—Local 
Upgrade” section on page 2-17.

To perform a Remote upgrade, see “Upgrading from earlier versions—Remote 
Upgrade” section on page 2-28

Upgrade installation preserves the settings from the product installed earlier.

Upgrading from earlier versions—Local Upgrade

Cisco recommends that you save your data to a backup file before you perform 
the local upgrade. If your installation fails, you can retrieve this saved data. 

Local upgrade overrides the previous versions. The old version will not be 
available after you upgrade to CiscoWorks Common Services 2.2.

Earlier versions of CiscoWorks products are not fully compatible with 
CiscoWorks Common Services 2.2. The earlier versions are disabled when you 
upgrade. After installation is completed, data from previous versions get carried 
over to the new version and restores the active state of the products.
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Backing Up Your Data

To backup your data:

Step 1 Access the CiscoWorks desktop and log in.

For information, see Accessing the Server section and Logging In section in the 
Userguide for CiscoWorks Common Services

Step 2 Select Server Configuration > Administration > Database Management > 
Back Up Data Now.

The Back Up Data Now dialog box appears.

Step 3 Enter the pathname of the target directory. 

It is recommended that you use a different directory from the directory where 
CiscoWorks is located, for example, C:\backups.

Step 4 To begin the backup, click Finish. 

This process could take some time to complete. For more information, see the 
online help.

Before starting an upgrade, all currently scheduled jobs must be suspended. 
Necessary data can then be exported during upgrade to the new version. This data 
allows dependent applications to re-enable jobs after upgrade. 
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Running the Installation Program

To run the installation program:

Step 1 Install the required software as described in the “Server Requirements” section on 
page 1-2.

• If you are running Windows, make sure Service Pack 3 is installed. 

Note With Service Pack 2, CiscoWorks Common Services will install. 
However, it dsplays a warning to proceed at your own risk. 

• If you have Service Pack 1, the installation stops.

• If you are running virus scan while installing CiscoWorks Common Services, 
the installation might take longer to complete.

• If you are running HP OpenView, the installation might take significantly 
longer to complete. Stop all HP OpenView services before installing 
CiscoWorks Common Services. 

Insert the CiscoWorks Common Services CD-ROM into a CD-ROM drive. The 
Installer screen appears.

Step 2 Click Install to continue. 

The Welcome screen appears.

Step 3 Click Next to continue. 

The software License Agreement dialog box appears.

Step 4 Click Yes to accept the license agreement and proceed with the installation.

The Setup Type dialog box appears. 

To deny the agreement and stop the installation, click No.
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Step 5 Select one of the following:

• Express to install all CiscoWorks Common Services components in the 
default location with default settings.
(See the Upgrade Installation—Express, page 2-20.)

• Typical to select CiscoWorks Common Services components and install the 
selected components in a specific location. This is the default installation 
mode.
(See the Upgrade Installation—Typical, page 2-21.)

• Custom to select optional components, customize the settings, and to specify 
the location.
(See the Upgrade Installation—Custom, page 2-23.)

Upgrade Installation—Express
If you select the Express option:

Step 1 Click Next to continue. 

The installation program checks dependencies and system requirements. The 
Requirements Verification dialog box appears. 

The Requirements Verification dialog displays the system requirements, 
available space in the drive and Temp Directory (%TEMP%), and available 
memory in megabytes.

• If your system does not meet the requirements a warning appears: 

System memory is less than the minimum requirement, which may 
affect performance.

• If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Free some space on 
drive drive name

If you have not entered a password for CiscoWorks admin user during the 
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enter a new password for the installation to proceed.
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If you have not entered a password for CiscoWorks guest user during the previous 
installation, the Change Guest Password dialog box appears. You must enter a 
new password for the installation to proceed.

Step 2 Click Next to continue. 

The Summary dialog box appears. The Summary dialog box shows the summary 
of settings for the installation.

If you want to view passwords and security sensitive data, click Show Details. 
You can select and copy the data from the Summary dialog box. 

Step 3 Click Next to continue. 

After the installation is completed, End of Installation dialog box appears.

Step 4 Select Yes, then click Finish.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.

Caution You must restart your system after installation is complete. The installation of 
other CiscoWorks products may fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation” 
appendix.

Upgrade Installation—Typical 
If you select the Typical option: 

Step 1 Click Next to continue. 

The installation program checks dependencies and system requirements. The 
Requirements Verification dialog box appears. 

The Requirements Verification dialog displays the system requirements, 
available space in the drive and Temp Directory (%TEMP%), and available 
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• If your system does not meet the requirements a warning appears:

System memory is less than the minimum requirement, which may 
affect performance.

• If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Free some space on 
drive drive name.

If you have not entered a password for CiscoWorks admin user during the 
previous installation, the Change Admin Password dialog box appears. You must 
enter a new password for the installation to proceed.

If you have not entered a password for CiscoWorks guest user during the previous 
installation, the Change Guest Password dialog box appears. You must enter a 
new password for the installation to proceed.

Step 2 Click Next to continue. 

The Summary dialog box appears. The Summary dialog box shows the summary 
of settings for the installation.

To view passwords and security sensitive data, click Show Details. The 
installation program displays only the new and changed passwords. You can 
select and copy the data from the Summary dialog box. 

Step 3 Click Next to continue. 

The installation of CiscoWorks Common Services proceeds. 

After the installation is completed, End of Installation dialog box appears.

Step 4 Select Yes, then click Finish.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.

Caution You must restart your system after installation is complete.The installation of 
other CiscoWorks products may fail if you do not restart.
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Upgrade Installation—Custom
Custom option preserves the settings from the product installed earlier. Dialog 
boxes appear with the settings from the previous installation. You can accept 
these values or modify them.

If you select the Custom option:

Step 1 Click Next to continue. 

The Requirements Verification dialog box appears. The Requirements 
Verification dialog displays the system requirements, available space in the drive 
and Temp Directory (%TEMP%), and available memory in megabytes.

• If your system does not meet the requirements a warning appears:

System memory is less than the minimum requirement, which may 
affect performance.

• If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Free some space on 
drive drive name

Step 2 Click Next to continue. 

The Change Admin and Guest Password dialog box appears. 
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Step 3 Enter CiscoWorks Admin and Guest passwords and confirm it. 

For more information on passwords, see “Password Information”appendix. 

Step 4 Click Next to continue installation. 

The Casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server without 
having administrative privileges. 

Step 5 Enter the password and confirm it. 

Leave the fields blank to use the existing password.

This password must conform to the system administrator policies. The installation 
program adds the user casuser and the group casusers to the system.

For more information on passwords, see “Password Information”appendix.

Step 6 Click Next to continue installation. 

If you have Then
Entered both CiscoWorks admin and 
guest user passwords during the 
previous installation.

Leave the fields blank to retain the 
existing passwords.

Not entered CiscoWorks admin and 
guest user passwords during the 
previous installation.

Enter new passwords for the 
installation to proceed.

Entered the admin user password and 
left the guest user password field blank 
during the previous installation.

Installation retains the existing 
password for the admin user and 
generates a random password for guest 
user.

Entered the guest user password and 
left the admin user password field 
blank during the previous installation.

Enter a new password for admin user. 
Leave the guest password field blank 
to retain the existing password.
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The User Management dialog box appears. This dialog box allows you to specify 
whether the users are managed locally by CiscoWorks Common Services or by 
the Access Control Server (ACS).

• If you choose to manage users locally, then click Next, CiscoWorks Common 
Services Database Password dialog box appears. Go to Step 8.

• If you choose ACS option, then click Next, Access Control Server dialog box 
appears.

Step 7 Enter Access Control Server information. 

Installation does not attempt to access ACS. You can modify the ACS properties 
later using the user administration.

Step 8 Click Next to continue installation. 

The CiscoWorks Common Services Database Configuration dialog box appears. 

Step 9 Enter the password, and confirm it. 

Leave the fields blank to use the existing password.

For more information on passwords, see “Password Information” appendix.

Step 10 Click Next to continue installation. 

The Licensing Database configuration dialog box appears. 

Step 11 Enter the port number, database password, and confirm it. 

The default port number is 10033. Leave the password field blank to use the 
existing password.

For more information on passwords, see “Password Information” appendix.

Step 12 Click Next to continue installation. 

The Web Server Configuration dialog box appears. 

Step 13 Enter HTTPS port, server administrator e-mail address, and the SMTP server 
name. 

The default HTTPS port number is 443. The SMTP server name is used by other 
CiscoWorks modules.

Step 14 Click Next to continue installation. 

The Self-signed Certificate dialog box appears. The webserver uses the 
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Step 15 Enter the country code, state, city, company, organization, and host name for 
HTTPS. 

The host name is mandatory.

Step 16 Click Next to continue installation. 

The Shortcut Creation dialog box appears. 

Step 17 Select Create a short cut to CiscoWorks on the Desktop to create the shortcut.

Step 18 Click Next to continue installation. 

The Integration Utility dialog box appears.

Step 19 Select one of the following:

• Integrate Later to integrate with a third-party NMS after installation. This 
completes the installation more quickly and avoids installation failure due to 
errors in the third-party integration.
If you select Later, skip to Step 19.

• Integrate Now to integrate with a third-party NMS during installation.
If you select Integrate Now, continue with steps a through d.

a. Click Next to continue. The Integration Utility dialog box appears, 
displaying a list of adapters.

b. Select the adapter from the list of available adapters, or select other to 
choose an adapter that is not listed (you will be prompted to enter the path 
name of the adapter), or select none to integrate after the installation is 
complete.
If you select none, skip to Step 19.
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The Integration Utility dialog box appears, asking if you want to enable 
download options from the Cisco Web page (Cisco.com).

Note If you are installing only the Integration Utility, enter the CiscoWorks 
server name, protocol type (HTTP, HTTPS) and port number.

c. Select one of the following:

– No to disable future upgrades from the Cisco Web page. 

– Yes to enable future upgrades from the Cisco Web page.

d. Enter your Cisco.com user ID and password.

You must have Cisco.com login privileges. If you do not have a user 
account and password on Cisco.com, contact your channel partner or 
enter a request on the standard Cisco.com web site.

Step 20 Click Next to continue. 

The Summary dialog box appears, displaying the summary of settings for the 
installation.

To view passwords and security sensitive data, Click Show Details. The 
installation program displays only the new and changed passwords. You can 
select and copy the data from the Summary dialog box. 

Step 21 Click Next to continue. 

The installation of CiscoWorks Common Services proceeds. After the installation 
is completed, End of Installation dialog box appears.

Step 22 Select Yes, then click Finish.

To prepare the client system for use, see the “Preparing to Use CiscoWorks 
Common Services” chapter.

Caution You must restart your system after installation is complete. The installation of 
other CiscoWorks products may fail if you do not restart.
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Upgrading from earlier versions—Remote Upgrade

If you do not want to overwrite your current version of CiscoWorks Common 
Services, you can perform a remote upgrade. During a remote upgrade, you install 
CiscoWorks Common Services on a new system and export all required data to 
the new system from the system running the previous version. 

Step 1 Install CiscoWorks Common Services on the new system. See the “Performing a 
New Installation” section on page 2-7.

Step 2 Remove the CiscoWorks Common Services CD-ROM from the new system.

Before starting an upgrade to CiscoWorks Common Services, relevant data from 
all jobs must be exported to the new system. 

To export the data:

Step 1 The CiscoWorks Common Services CD-ROM should be in the CD-ROM drive of 
the system running the old version of CiscoWorks Common Services. Go to the 
root directory on the CiscoWorks Common Services CD-ROM.

Step 2 Run the script export_cdone.pl

%NMSROOT%\bin\perl export_cdone.pl

%NMSROOT% is the directory in which CiscoWorks Common Services is 
installed. The default NMSROOT directory is 
Default_Installation_Drive:\Program Files\CSCOpx. 
The script prompts you for the location where you want to store the data to be 
exported.

Step 3 To accept the default location for storing the exported data, press Enter.

The default location is %NMSROOT%\rigel.

If you do not want to use the default location, enter an alternate location, and press 
Enter.

The remote upgrade tool exports the data and creates the directories cmf and 
manifest\cmf at the location specified for backing up the data. For example, if you 
2-28
Installation and Setup Guide for Common Services (Includes CiscoView) on Windows

78-15430-01

choose C:\backup as the back up location, the remote upgrade tool creates the 
directories C:\backup\cmf and C:\backup\manifest\cmf to store the exported data.



 

Chapter 2      Installing CiscoWorks Common Services
Performing an Upgrade Installation

Step 4 Copy the directories cmf and manifest from the system running the old version of 
CiscoWorks Common Services into %NMSROOT%\rigel on the system running 
the new version of CiscoWorks Common Services.

Step 5 On the new system, go to the directory %NMSROOT%\rigel\scripts, then 
run perl import_cdone.pl.

Step 6 Run the data import script:

%NMSROOT%\bin\perl import_cdone.pl 

The remote upgrade tool imports the data exported from the remote system.

The upgrade is now complete and all necessary data from the previous version of 
CiscoWorks Common Services has been exported.

Note During the remote upgrade, the user information from the source is merged with 
the new user information.

Reinstalling CiscoWorks Common Services
To reinstall CiscoWorks Common Services, follow the steps under Performing an 
Upgrade Installation, page 2-16.

• If you leave any field blank, CiscoWorks will use the values from the 
previous installation. 

If you have not entered a password for CiscoWorks admin or guest user 
during the previous installation, you must enter a new password for the 
installation to proceed.

• If you select custom mode during reinstallation, all dialogs show the default 
values or the settings from the previous installation. You can accept these 
values or modify them.

During reinstallation, the installation attempts to use existing passwords. If the 
installation fails to generate random passwords, you may provide the passwords 
manually. 
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During reinstallation, you can preserve the self-signed certificate. Select Keep 
existing certificate option to configure the webserver to use existing certificate.

Note If CiscoWorks Common Services has previously been installed on this 
system, the product will automatically be installed at the same location 
where CiscoWorks Common Services was previously installed.

Verifying the Installation
You can verify product installation by entering the command net start from DOS 
prompt. The following services should be displayed:

• CiscoWorks Tomcat Servlet Engine

• CiscoWorks Daemon Manager

• CiscoWorks Sybase Server

• CiscoWorks VisiBroker Smart Agent

• CiscoWorks Web Server

• CWCS rsh/rcp service

• CWCS syslog service

• CWCS tftp service

• JRUN Proxy Server for CWCS.

Uninstalling CiscoWorks Common Services
Use the Uninstall option to remove CiscoWorks Common Services files and 
settings. You must be logged in as administrator to remove CiscoWorks Common 
Services.

You cannot uninstall CiscoWorks Common Services when you have CiscoView 
and Integration Utility installed. Before uninstalling CiscoWorks Common 
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If you select CiscoWorks Common Services with out selecting CiscoView, the 
following message appears:

Cannot uninstall CiscoWorks Common Services.
It is required for CiscoView.

Uninstall all applications dependent on CiscoWorks Common Services before 
uninstalling CiscoWorks Common Services.

Caution You must use the Uninstall option of the CiscoWorks Common Services 
installation program to remove the product. If you try to remove CiscoWorks 
Common Services or its components manually, you may damage your system.

Step 1 From the Windows desktop, select Start  > Programs  > CiscoWorks >  
Uninstall CiscoWorks. 

The Uninstallation dialog box appears, displaying installed components.

Step 2 Select the components you want to remove, then click Next.

or 

Click Uninstall All to uninstall all the components.

A dialog box appears with the list of selected components.

Step 3 Click Next to continue uninstallation. 

or 

Click Back to return to the component selection box. If you have selected 
Uninstall All, you cannot return to the component selection box using back 
button.

Messages about uninstall preparation appear and the uninstallation finishes. 

Caution You must restart the system after uninstallation to make sure all the registry 
entries are deleted.
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C H A P T E R 3
Preparing to Use CiscoWorks 
Common Services

Now that you have installed CiscoWorks Common Services, you must configure 
the client system to use CiscoWorks Common Services.

This chapter consists of:

• Configuring Client Systems

• Accessing the Server

• Using CiscoView

The server system can be used as both the client and server, in which case you 
must configure the web browser on the server.

Configuring Client Systems
Configure your client system to be used with CiscoWorks Common Services 
software.
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Set Display Fonts
For Microsoft Windows systems, set the display to use small fonts:

Step 1 Select Start  >  Settings  >  Control Panel. 

The Control Panel window appears.

Step 2 Double-click the Display icon. 

The Display Properties dialog box appears.

Step 3 Click the Settings tab. 

• If Small Fonts is selected in the Font Size list, your display font is set 
correctly.

• If Small Fonts is not selected, select it from the Font Size drop-down list, 
then click OK.

The System Settings Change dialog box appears.

Step 4 If you changed the font size, click Yes to restart your system.

Configure Web Browser
To configure your web browser:

Step 1 Enable Java and JavaScript:

• Netscape Navigator—Select Edit  > Preferences  >  Advanced. Select the 
Enable Java and Enable JavaScript check boxes, and click OK.

• Microsoft Internet Explorer—Select Tools > Internet Options > 
Advanced. Under the Microsoft VM heading, select Java console enabled, 
JIT compiler for virtual machine enabled, and Java logging enabled and 
click OK.
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Step 2 Set your browser cache to at least 6 MB:

• Netscape Navigator—Select Edit  >  Preferences  >  Advanced  >  Cache. Set 
both the memory cache and the disk cache to at least 6144 KB and click OK.

• Internet Explorer—Select Tools > Internet Options > General, then click 
Settings. Set the cache to at least 6 MB using the Amount of disk space to use 
slide bar. Click OK to close the Settings dialog box and return to the Internet 
Options dialog box, then click OK again.

Step 3 Configure your browser to accept all cookies:

• Netscape Navigator—Select Edit  > Preferences  >  Advanced. Select the 
Accept all cookies radio button, then click OK.

• Internet Explorer—Select Tools  > Internet Options  >  Privacy. Scroll the 
settings bar down to select Accept all Cookies. Click OK.

Step 4 Configure your browser to compare each page with its cached version every time 
it loads a page:

• Netscape Navigator—Select Edit  > Preferences  > 
Advanced  > Cache. Select the Every Time radio button, then click OK.

• Internet Explorer—Select Tools  >  Internet Options > General, then click 
Settings under Temporary Internet files group. Select the Every visit to the 
page radio button, then click OK twice.

Note This option must be set to prevent Internet Explorer from using the cached 
information for help links. If it is not set, the first help link is displayed 
properly. However, the second time you click a link, the first page is 
displayed again.

Step 5 Change the default timeout to 20 minute. This is only for Internet Explorer —See 
the instructions on the Microsoft Support Web site.

Step 6 Enable style sheets:

• Netscape Navigator—Select Edit > Preferences  >  Advanced. Select the 
Enable Style Sheets check box, then click OK.

• Internet Explorer—Select Tools> Internet Options >  General, then click 
Accessibility. Make sure that the Format documents using my style sheet 
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Step 7 Change the default font to sans-serif for improved readability:

• Netscape Navigator—Select Edit  > Preferences  > Appearance  >  Fonts. 
Select a sans-serif font (for example, Arial) and a font size in the Variable 
Width Font and Fixed Width Font selection areas, then click OK. The text 
in the browser window is redrawn using the new fonts.

• Internet Explorer—Select Tools  > Internet Options  > General, then click 
Fonts. Select a sans-serif font (for example, Arial) from the Web page font 
and Plain text font lists, then click OK. Click OK to close the dialog box. 
The text in the browser window is redrawn using the new fonts.

If you have browser problems after configuring your browser, increase your disk 
cache settings.

After the web browser is installed on the client system, there are no additional 
disk space requirements. However, because the browser uses the local disk to 
store cached information, make sure you have enough disk space for the amount 
of cached information you want to store. All CiscoWorks Common Services 
information is stored on the CiscoWorks Server.

Configure the Integration Utility
The Integration Utility allows you to launch CiscoView from an SNMP platform 
even when CiscoView is running on a different system than the NMS. It also 
allows you to integrate other applications into NMS menu.

See Using CiscoView for information about configuring the Integration Utility.
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Accessing the Server
CiscoWorks Common Services uses port 1741 for the HTTP server and port 1742 
for HTTPS server (SSL). 

To access the server from a client system, enter any one of these URLs in your 
web browser:

• If SSL is disabled and if you installed CiscoWorks Common Services on the 
default port, and enter:

http://server_name:1741

• If SSL is enabled, and if you installed CiscoWorks Common Services on the 
default port, enter:

https://server_name:1742

where server_name is the hostname of the server on which you installed 
CiscoWorks Common Services.

In addition, see the “TCP and UDP Ports Used” section.

In the main CiscoWorks desktop, the Login Manager appears. See User Guide for 
CiscoWorks Common Services for information about logging in.

Using CiscoView
CiscoView is a graphical SNMP-based device management tool that provides 
real-time views of networked Cisco Systems devices. 

See Using CiscoView 5.5 for information about launching and using CiscoView.
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Any CiscoWorks user can view the st
Configuration > Administration > P
Process Status from the CiscoWorks 
A P P E N D I X A
Troubleshooting the Installation

This appendix provides troubleshooting information for CiscoWorks Common 
Services installation. It contains:

• Checking Processes After Installation

• Viewing and Changing Process Status

• Calling the Technical Assistance Center (TAC)

• Understanding Installation Messages

• Setting Up the Browser

Checking Processes After Installation
You can run a self test or view process failures from the CiscoWorks Server. 
To run a self test, select Server Configuration  >  Diagnostics  > Self Test from 
the navigation tree. 

To view process failures, select Server Configuration  >  Diagnostics  >  Process 
Failures from the navigation tree.

Viewing and Changing Process Status
A-1
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Note From the browser, only users with administrative privileges can start and stop 
processes.
From the server, only users with administrative privileges can start and stop 
processes.

To stop processes from the browser:

Step 1 Select Server Configuration > Administration > Process Management  > Stop 
Process. 

The Stop Process dialog box appears.

Step 2 From the dialog box, select System, to stop all processes, or select only the 
processes that you want to stop.

If you select specific processes, the process dependencies will also be stopped. If 
you select System, all processes except WebServer and JRunProxy Server will be 
stopped.

To start processes from the browser:

Step 1 Select Server Configuration > Administration > Process Management > Start 
Process. 

The Start Process dialog box appears.

Step 2 From the dialog box, select System, to start all processes, or select only the 
processes that you want to stop. 

If you select specific processes, the process dependencies will not be started 
automatically.

To stop all processes from the server:

Select Run from the Start menu and enter, net stop crmdmgtd
A-2
Installation and Setup Guide for Common Services (Includes CiscoView) on Windows

78-15430-01

To start all processes from the server:

Select Run from the Start menu and enter, net start crmdmgtd



 

Appendix A      Troubleshooting the Installation
Calling the Technical Assistance Center (TAC)

Calling the Technical Assistance Center (TAC)
If you had problems while installing CiscoWorks Common Services, before 
calling TAC:

• Make sure the system hardware and software requirements are met.

• Make sure the disk space is not full.

• Make sure the CD ROM drive is not defective: mount the CD ROM remotely 
on a different machine and retry installing CiscoWorks Common Services.

If the above conditions are met, and you still have problems, contact the Technical 
Assistance Center (TAC) or refer to the following URL:
http://www.cisco.com/warp/customer/477/32.shtml.

TAC representatives may ask you to send them the installation log file, 
system drive:\Ciscoworks_setup001.log file (or the log file with the highest 
number, for example, Ciscoworks_setup003.log).

Tip Create a report and email the generated report to TAC.
From the CiscoWorks Server navigation tree, select Server Configuration  > 
Diagnostics  > Collect Server Information.
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Understanding Installation Messages
Table A-1 shows messages that might occur during installation and describes the 
reasons for the errors.

Table A-1 Installation Messages

Message Reason for Message User Action

CiscoWorks Common Services 
installation cannot proceed 
because you are not logged in as 
an administrator.

You are not logged in to Windows 
with administrator privileges.

Log in to Windows with local 
administrator privileges and 
try installing again.

Decompression failed on file. The 
error was for error code per 
CompressGet.

When you downloaded 
CiscoWorks Common Services, a 
transmission error occurred or the 
installation medium is damaged.

Retry the download. If you 
still have errors, contact your 
technical support 
representative.

General file transmission error. 
Please check your target location 
and try again. Error number: error 
code.

When you downloaded 
CiscoWorks Common Services, a 
transmission error might have 
occurred. 

Retry the download. If you 
still have errors, contact your 
technical support 
representative.

Severe: Cannot run the 
dependency handler.

When you downloaded 
CiscoWorks Common Services, a 
transmission error might have 
occurred.

The directory structure of 
installation is not maintained. 
This can happen if you download 
the zip file, then extract the 
contents to install from it.

Retry the download.
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Unable to write infoFile or Unable 
to create infoFile.

A file-write operation failed. Run the file system checking 
utility, then repeat the 
installation.

Verify that you have write 
permission to the destination 
directory and windows TEMP 
directory, then repeat the 
installation. The environment 
variable %TEMP% provides 
the location on TEMP 
directory.

Cannot stop service servicename. The installation (or reinstallation) 
tried to stop the service 
servicename unsuccessfully.

Select Control Panel > 
Services and stop service 
servicename manually, then 
proceed with (un)installing.

UseDLL failed for dll. dll is supposed to be available at 
any time for any process, but 
Windows failed to load it.

Check permissions on the 
system32 directory under 
%WINDIR%. If the dll is 
secure.dll or r_inst.dll, check 
product installation media for 
errors.

or

Reinstall Windows.

function failed: DLL function not 
found.

dll is supposed to be available at 
any time for any process, but 
Windows failed to load it.

Check permissions on 
system32 directory under 
%WINDIR%. If dll is 
secure.dll or r_inst.dll, check 
product installation media for 
errors.

or

Reinstall Windows.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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OpenFile failed: pathname. A file open operation failed. Run the file system checking 
utility, then repeat the 
installation.

Verify whether you have the 
read permission on pathname, 
then repeat the installation.

ProtectFile failed: file: error. 
WWW admin security may be 
incomplete.

Setting file permissions failed 
because you may not be allowed 
to change them.

Log in as administrator.

If you are installing on a FAT 
file system, CiscoWorks 
Common Services cannot 
provide file security.

Launch of isql script failed. The existing database file is 
broken, or the previous version of 
CiscoWorks Common Services is 
destroyed. (The problem may 
occur during reinstallation.) 

Contact your technical support 
representative.

The product should not be 
installed in a root directory.

You tried to install the product in 
a directory of a drive (for 
example, c:\ or d:\) that is not 
supported.

Choose a directory other than 
the root directory to install the 
product.

The product should not be 
installed in a remote directory.

You tried to install the product in 
a directory of a drive that is 
remotely mounted or using the 
UNC pathname.

Choose a directory on a local 
hard-drive.

The selected directory is not 
empty. Mixing new and existing 
files can cause severe problems 
during installation.

You tried to install in a directory 
that contains some files.

Remove all files from 
directory or choose another 
directory to install the product.

The installer requires temporary 
workspace. You have less than 8 
MB of free space on drive. Please 

There is not enough drive space 
for temporary installation files.

Make more drive space 
available (%TEMP%), then 
rerun installation.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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You are attempting to install 
CiscoWorks Common Services 
2.2 with CiscoView 5.5 and 
Integration Utility 1.5 on a Server 
which is configured as a Primary 
Domain Controller or a Backup 
Domain Controller (PDC/BDC).  

CiscoWorks Common Services 
2.2 with CiscoView 5.5 and 
Integration Utility 1.5 is only 
supported on Windows 2000 
Professional and Windows 2000 
Server with Service Pack 3 or 
higher.  Install CiscoWorks 
Common Services 2.2 with 
CiscoView 5.5 and Integration 
Utility 1.5 on another server not 
configured as PDC / BDC.  

The installation application will 
exit when you close this message 
box.

You are installing the application 
on a Server which is configured 
as a Primary Domain Controller 
or a Backup Domain Controller 
(PDC/BDC)

Install CiscoWorks Common 
Services 2.2 with CiscoView 
5.5 and Integration Utility 1.5 
on another server not 
configured as PDC / BDC.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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You are attempting to install 
CiscoWorks Common Services 
2.2 with CiscoView 5.5 and 
Integration Utility 1.5 on an 
unsupported operating system. 
CiscoWorks Common Services 
2.2 with CiscoView 5.5 and 
Integration Utility 1.5 is 
supported only on Windows2000 
Profiessional or Window2000 
Server with Service Pack 3 or 
higher. 

The installation application will 
exit when you close this message 
box. 

Either upgrade the Operating 
System on the Server to a 
supported version or install 
CiscoWorks Common Services 
2.2 with CiscoView 5.5 and 
Integration Utility 1.5 on another 
server running a supported 
Operating System.

You are installing the application 
on an operating system that does 
not match System Requirements 
for the product.

Upgrade the Operating System 
on the Server to a supported 
version or install CiscoWorks 
Common Services 2.2 with 
CiscoView 5.5 and Integration 
Utility 1.5 on another server 
running a supported Operating 
System.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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You are attempting to install 
CiscoWorks Common Services 
2.2 with CiscoView 5.5 and 
Integration Utility 1.5 on 
operating system and service 
pack. CiscoWorks Common 
Services 2.2 with CiscoView 5.5 
and Integration Utility 1.5 is 
supported only on Windows2000 
Profiessional or Window2000 
Server with Service Pack 3 or 
higher. No other Service Packs 
have been certified as compatible.  
When requesting support, it will 
be necessary to have the 
CiscoWorks product installed on 
Windows 2000 with Service Pack 
3 or higher. Do you want to 
proceed ?

You are installing the application 
on an operating system that does 
not match System Requirements 
for the product

If you are installing on Service 
Pack 2, you can proceed with 
the installation and upgrade to 
Service Pack 3 after 
completing installation and 
before running the product.  
However, the installation will 
exit if you are running Service 
Pack 1 or if no Service Pack is 
detected.

We recommend that you run the 
installation from a local CD or a 
local hard drive to avoid errors 
that may result from the network 
being slow or busy.

Do you want to proceed ?

Click Yes to proceed with this 
installation. 

Click No to exit installation.

You are installing the product 
from a copy of the CD or from the 
CD drive of another system in the 
network through Network 
Neighborhood.

Map the drive locally using the 
net use command or Tools > 
Map Network Drive in 
Explorer. Run the installation 
from the local mapping.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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The installation image is being 
accessed as 
\\servername\sharename. 
Installation can run only from a 
local or mapped drive.

We recomment that you run the 
installation from a local CD or a 
local hard drive to avoid errors 
that may result from the network 
being slow or busy.

Click OK to exit installation.

Youare installing the product 
from another system in the 
network through Network 
Neighborhood.

Copy the installable to a local 
drive or use local CD drive.

or

Map the drive locally using the 
net use command or Tools > 
Map Network Drive in 
Explorer. 

Run the installation from the 
local mapping.

The default (or selected) drive 
drive has a(n) file-system-type file 
system. This file system does not 
support file security. The cluster 
size is cluster size bytes, therefore 
disk space requirements can be 
high. 

• Choose another directory to 
install CiscoWorks Common 
Services

• Use default or selected 
directory to install 
CiscoWorks Common 
Services

You are trying to install onto a 
drive with a non-NTFS (FAT or 
FAT32) file system. The file 
system may not support security. 
The cluster size may be bigger 
than 4096 bytes.

Click to choose the directory 
you want to install 
CiscoWorks.

Setup has detected that 
unInstallShield is in use. Close 
unInstallShield and restart setup.  
Error 432.

You do not have permission to 
write to the %WINDIR% 
directory.

Verify that you have 
appropriate permissions to 
write to %WINDIR%.  
Installation or unInstallation 
has to be done by a member of 
local Administrators group.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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The product can be installed only 
in a folder that does not have 
spaces or can be converted into 
8.3 form. Choose another 
destination folder. 

The destination directory 
contains spaces in the directory 
name and the directory name 
cannot be converted to a 
MS-DOS format.

Install the product in a 
directory whose fully qualified 
pathname does not contain any 
spaces or has MS-DOS name 
aliases.  Check the presence of 
MS-DOS aliases, using dir /x 
command in a command-line 
window.

Cannot determine the local 
Administrators group.

The installation program cannot 
find one of the built-in Windows 
user groups. This prohibits 
CiscoWorks Common Services 
security setup.

Check the Operating System. 
Reinstall Windows if 
necessary, then rerun 
CiscoWorks Common 
Services installation.

Cannot determine the local 
Everyone group.

The installation program cannot 
find one of the built-in Windows 
user groups. This prohibits the 
setup of CiscoWorks Common 
Services security.

Check operating system. 
Reinstall Windows if 
necessary, then rerun 
CiscoWorks Common 
Services installation.

Installation cannot create the 
default directory, directory name. 
You may not have permissions on 
the default directory or you have 
specified a read-only device. 

You may not have permissions on 
the directory.

Choose another destination 
directory.

Failed to set file permissions. The installation program is 
unable to set file permissions. 
Most likely causes are:

• The account you used to log 
in to the system has 
insufficient permissions.

• The drive on which you are 
installing product has a FAT 
file system.

Fix problem, then rerun 
installation program.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
A-11
Installation and Setup Guide for Common Services (Includes CiscoView) on Windows

78-15430-01



 

Appendix A      Troubleshooting the Installation
Understanding Installation Messages

task_name is already running! 
Wait for it to finish and press the 
OK button.

One installation subtask is still 
running.

Wait for installation subtask to 
finish running, then click OK 
to proceed.

Unable to create/open log file. The installation program was 
unable to create or open 
installation log file 
ciscoworks_setupxxx.log. xxx is a 
sequential number starting from 
001 (in root directory on system 
drive).

Determine why the file could 
not be created or opened, fix 
problem, then rerun 
installation. Common causes 
are lack of disk space or write 
protection on file.

Error creating / modifying casuser 
- name. Click Yes if you want to 
try again, click No if you want the 
Install to abort.

This error may happen if the 
passwords that you entered do not 
match the policies set by System 
Administrators or when user 
running the installation does not 
have permission to create new 
user on the system.

If you are not authorized to 
create users on the system, 
please contact your System 
Administrator.  

If you are authorized to create 
users on the system and are 
still seeing this error, Click 
Yes which will take you to a 
screen where you will be given 
another opportunity to reenter 
the passwords.  Please take 
corrective action to the 
problem as suggested by the 
error message.

Cannot find script to upgrade 
database.

Problem with database upgrade. Contact your technical support 
representative.

Database upgrade failed. Problem with database upgrade. Contact your technical support 
representative.

Database upgrade result 
unknown.

Problem with database upgrade. Contact your technical support 
representative.

Table A-1 Installation Messages (continued)
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The installer has discovered HP 
OpenView services running. The 
installation might take 
significantly longer to complete 
with these services running.

HP OpenView services are 
running.

Stop all HP OpenView 
services before installing 
CiscoWorks. (You do not have 
to restart the system after 
stopping HP OpenView.)

 ODBC Driver Manager 3.510 or 
later is required by CiscoWorks 
Common Services. Please install 
ODBC 3.510 first.

CiscoWorks Common Services 
software requires ODBC Driver 
Manager version 3.510 or later.

Install Microsoft Data Access 
Component (MDAC) 2.1 or 
higher.  

Make sure that all ODBC Core 
Components have the same 
version number. 

Refer to Microsoft web site for 
installation instructions.  

ODBC is not available from 
Microsoft as a stand-alone 
installation but is packaged 
along with MDAC.

DNS check of system name failed 
for one of the following reasons: 

- Your DNS is not working. 

- Your DNS is slow.

- The host name of this server is 
not in DNS 

You may proceed with 
installation. However, you must 
correct DNS before running the 
product. 

Your DNS is not working as 
expected.

Correct the DNS problem, 
then continue the installation.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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These files are currently being 
used by another running process. 
You must stop all processes listed 
below to proceed successfully 
with this installation.

Click Next to proceed with the 
installation.

Click Cancel to exit.

Some of the executables and 
DLLs installed by CiscoWorks 
are locked. 

Stop all applications. Stop 
IPM if it is running. Close 
Browsers and make sure 
CiscoWorks CLIs are not used 
at the moment. After stopping 
all the applications, proceed 
with the installation.

Do you want to verify that 
CiscoWorks files are no longer 
being used by running processes? 
Click Yes to verify that files are 
no longer in use and that the 
installation may proceed.

Click No to proceed without 
verification.

Some of the executables and 
DLLs installed by CiscoWorks 
are in use.

Verify that files are no longer 
in use.

If some files are in use, follow 
these steps to make sure all 
processes are stopped:

1. Cancel installation.

2. Stop the CiscoWorks and 
change the startup type 
from Automatic to 
Manual.

3. Restart the system.

4. Try to run command net 
start from MSDOS 
window. The output 
should not show any 
CiscoWorks or 
CiscoWorks Common 
Services daemon manager 
running.

5. Run the installation again.

Table A-1 Installation Messages (continued)
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The instruction at location 
referenced memory at location. 
The memory cannot be read. Click 
OK to terminate the program. 
Click CANCEL to debug the 
program.

This message appears when you 
install CiscoWorks Common 
Services on a Pentium IV 
machine.

Click OK, and ignore the 
message. The installation will 
contine normally. 

The following services need to be 
stopped:

crmlog

crmtftp

crmrsh

Click Yes to stop them now, No to 
cancel installation.

These services will be restarted 
automatically after reboot.

Some of the services are running. Click Yes and continue with 
the installation.

java.exe has generated errors and 
will be closed by Windows. You 
will need to restart the program. 
An error log is being created.

This message appears when you 
install CiscoWorks Common 
Services on a Pentium IV 
machine.

Click OK, and ignore the 
message. The installation will 
contine normally. 

CreateService - service name - 
The specified service is marked 
for deletion.

The registry entries related to the 
service is not deleted during the 
uninstallation.

Restart the machine and 
reinstall CiscoWorks Common 
Services.

If the problem still exists, 
Uninstall CiscoWorks 
Common Services, restart the 
machine, then start a fresh 
installation.

Table A-1 Installation Messages (continued)
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Setting Up the Browser
If you have problems using the desktop, make sure the browser is configured 
correctly:

• The desktop buttons are active only if Java, JavaScript and Java Plugin are 
enabled. Make sure you enable Java and JavaScript as described in the 
“Preparing to Use CiscoWorks Common Services” chapter, “Configuring 
Client Systems” section on page 3-1.

Note If you are using Netscape Navigator, install it first and then install Java Plug-in.

• Uncheck Edit > Preferences > Advanced > Enable Java Plugin for 
Netscape Navigator 4.78 and 4.79.

• Make sure your cache is not set to zero. If you have browser problems, 
increase your cache settings as explained in the “Preparing to Use 
CiscoWorks Common Services” chapter, “Configuring Client Systems” 
section on page 3-1. 

• Do not resize the browser window while the desktop or main page is still 
loading. This can cause a Java error.
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A P P E N D I X B
Password Information

This appendix provides information on the usage of passwords in CiscoWorks 
Common Services installation. It contains:

• CiscoWorks Common Services Admin Password

• CiscoWorks Common Services Guest Password

• CiscoWorks Common Services Database Password

• Licensing Database Password

CiscoWorks Common Services Admin Password
While entering the CiscoWorks Admin passwords:

• Use a minimum of 5 characters.

• Do not start the password with a number.

• Do not insert spaces between charaters.

If you are installing the CiscoWorks Common Services for the first time, you must 
enter a valid password. 
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CiscoWorks Common Services Guest Password
While entering CiscoWorks Guest passwords:

• Use a minimum of 5 characters.

• Do not start the password with a number.

• Do not insert spaces between charaters.

If you are installing the CiscoWorks Common Services for the first time, you must 
enter a valid password. 

During upgrade and reinstall:

If you have Then
Entered both CiscoWorks admin and 
guest user passwords during the 
previous installation.

Leave the fields blank to retain the 
existing passwords.

Not entered CiscoWorks admin and 
guest user passwords during the 
previous installation.

Enter new passwords for the 
installation to proceed.

Entered the admin user password and 
left the guest user password field blank 
during the previous installation.

Installation retains the existing 
password for the admin user and 
generates a random password for guest 
user.

Entered the guest user password and 
left the admin user password field 
blank during the previous installation.

Enter a new password for admin user. 
Leave the guest password field blank 
to retain the existing password.
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CiscoWorks Common Services Database Password
While entering CiscoWorks Common Services Database passwords:

• The maximum number of characters the password can contain is 15.

• Do not start the password with a number.

• Do not insert spaces between charaters.

If you are installing the CiscoWorks Common Services for the first time, leave 
the fields blank for the installation program to generate random passwords. 
During upgrade and reinstall, leave the fields blank to use the passwords from the 
earlier installation.

Licensing Database Password
While entering Licensing Database passwords:

• The maximum number of characters the password can contain is 15.

• Do not start the password with a number.

• Do not insert spaces between charaters.

If you are installing the CiscoWorks Common Services for the first time, you must 
enter a valid password. During upgrade and reinstall, leave the fields blank to use 
the passwords from the earlier installation.
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A P P E N D I X C
User Inputs for the Installation

This appendix provides information on the user inputs for CiscoWorks Common 
Services installation. It contains:

• User Inputs for Express Installation

• User Inputs for Typical Installation

• User Inputs for Custom Installation

User Inputs for Express Installation
CiscoWorks Common Services and all dependent components are installed in 
%System drive%:\Program Files\CSCOpx\

In Express Mode, you must provide the following information during installation:

Table C-1 User Inputs for Express Installation

Settings Value

Password for admin user No default values. Enter the admin 
password. For more information on 
passwords refer “Password 
Information”
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User Inputs for Typical Installation
Enter the following information during installation in Typical mode:

User Inputs for Custom Installation
Enter the following information during installation in Custom mode:

Table C-2 User Inputs for Typical Installation

Settings Value

Destination folder The default location is 
%System drive%:\Program 
Files\CSCOpx\ 

Select another location if you want to 
install in a specific location.

Components to install Select the components you want to 
install.

Password for admin user No default values. Enter the admin 
password. For more information on 
passwords, see “Password 
Information”

Table C-3 User Inputs for Custom Installation

Setting Value

Destination folder The default location is 
%System drive%:\
Program Files\CSCOpx\ 

Select another location if you 
want to install in a specific 
location.

Components to install Select the components you want 
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Password for users admin and 
guest

No default values. Enter the 
admin and guest password. For 
more information on passwords, 
see “Password Information”

Password for user casuser The password is generated 
randomly if you leave the field 
blank.

Select one of the User 
Management modes: 

• Manage locally by 
CiscoWorks Common 
Services.

or

• Manage by Access Control 
Server (ACS).

If ACS mode is selected, enter 
the following server data:

• ACS Name

• ACS Port

• Admin User Name and 
Password

• Shared device key

By default, theUser Management 
mode is set to local, and ACS 
server data is empty.

If ACS mode is selected and if 
you leave the fields blank, the 
server name is set to 
tacacs.company.com and port is 
set to 49.

Password for the CiscoWorks 
Common Services database

By default, a random password is 
generated. For more information 
on passwords, see “Password 
Information”

Password and port for the 
Licensing database

The default port is 10033. Leave 
the password field empty to 
generate a random password. For 

Table C-3 User Inputs for Custom Installation (continued)

Setting Value
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Web server settings:

• HTTPS port

• Administrator’s e-mail 
address

• SMTP server name

The default values are:

Port number 443
admin@domain.com
localhost name

Data for the Self-signed 
Certificate:

• Country Code

• State

• City

• Company

• Organization

• Hostname

By default, the self-signed 
certificate is generated using the 
organization that Windows is 
registered to, and the host name.

Table C-3 User Inputs for Custom Installation (continued)

Setting Value
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